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BỘ 10 ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 CÓ ĐÁP ÁN CHI TIẾT 

1. Đề thi học kì 1 môn Tin 7 – Số 1 

TRƯỜNG THCS NGUYỄN DU ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

I. TRẮC NGHIỆM  

Câu 1. Cụm từ “F5” trong hộp tên có nghĩa là: 

A.Phím chức năng F5        

B.Ô ở hàng F cột 5 

C.Ô ở cột F hàng 5        

D.Phông chữ hiện thời là F5 

Câu 2. Muốn chọn hai khối không kề nhau ta nhấn cần nhấn giữ phím: 

A. Alt        

B. Shift        

C. Ctrl        

D. Enter 

Câu 3. Để lưu trang tính ta chọn lệnh: 

A. File\Open        

B. File\New        

C. File\Save        

D. File\Exit 

Câu 4. Để chọn một hàng trên trang tính, em thực hiện: 

A. Nháy chuột tại nút tên hàng 

B. Nháy chuột tại nút tên cột 

C. Đưa con trỏ chuột tại nơi đó và nháy chuột. 

D.Kéo thả chuột từ một ô góc đến ô ở góc đối diện 

Câu 5. Sau khi nháy chuột chọn 1 ô tính, nội dung dữ liệu trong ô tính đó được hiển thị ở 

đâu? 

A. Trên dải lệnh         

B. Trên thanh công thức 

C. Trên thanh trạng thái        

D. Trên cả 3 vị trí trên 
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Câu 6. Có thể quan sát ở đâu trên trang tính để biết được 1 ô chứa công thức hay chứa 

giá trị cụ thể? 

A. Thanh công cụ         

B. Thanh bảng chọn 

C. Thanh công thức        

D. Hộp tên 

Câu 7. Thanh công thức của Excel dùng để: 

A. Nhập dữ liệu hoặc công thức trong ô tính 

B. Hiển thị dữ liệu trong ô tính 

C. Hiển thị công thức 

D. Tất cả điều đúng 

Câu 8. Để sửa dữ liệu trong ô tính em cần: 

A. Nháy đúp chuột trái vào ô cần sửa.        

B. Nháy nút chuột trái 

C. Nháy đúp chuột phải vào ô cần sửa         

D. Nháy nút chuột phải 

II. TỰ LUẬN  

Câu 1. Nêu các bước điều chỉnh độ rộng cột, đột cao hàng?  

Câu 2. Hãy nêu các thao tác để sao chép nội dung ô tính?  

Câu 3. Cho bảng tính như hình sau: 

 

Yêu cầu: Dùng hàm thích hợp (sử dụng địa chỉ ô tính) để tính tổng điểm, điểm trung bình 

của mỗi học sinh  

 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 1 

I. TRẮC NGHIỆM 

1.C             2.C            3.C           4.A          5.B            6.C           7.D            8.A 

II. TỰ LUẬN 

Câu 1: * Các bước điều chỉnh độ rộng cột:  
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B1: Đưa con trỏ chuột vào vạch ngăn cách giữa hai cột. 

B2: Kéo thả chuột sang phải để mở rộng hay sang trái để thu hẹp độ rộng của cột. 

* Các bước điều chỉnh độ cao của hàng:  

B1: Đưa con trỏ chuột vào vạch ngăn cách giữa hai hàng. 

B2: Kéo thả chuột lên trên để thu hẹp hay xuống dưới để mở rộng độ cao của hàng. 

Câu 2: Các thao tác để sao chép nội dung ô tính là: 

Bước 1: Chọn ô có thông tin muốn sao chép. 

Bước 2: Nháy nút Copy trên thanh công cụ. 

Bước 3: Chọn ô muốn đưa thông tin tới. 

Bước 4: Nháy nút Paste trên thanh công cụ. 

Câu 3: Ô F4:=sum(C4,D4,E4) hoặc =sum(C4:E4) 

Ô F5:=sum(C5,D5,E5) hoặc =sum(C5:E5) 

Ô F6:=sum(C6,D6,E6) hoặc =sum(C6:E6) 

Ô F7:=sum(C7,D7,E7) hoặc =sum(C7:E7) 

Ô G4:=Average(C4:E4) 

Ô G5:=Average(C5:E5) 

Ô G6:=Average(C6:E6) 

Ô G7:=Average(C7:E7) 

2. Đề thi học kì 1 môn Tin 7 – Số 2 

TRƯỜNG THCS HAI BÀ TRƯNG ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

I. TRẮC NGHIỆM  

Câu 1. Cụm từ “G5” trong hộp tên có nghĩa là: 

A. Phím chức năng G5        

B. Ô ở hàng F cột 5 

C. Ô ở cột G hàng 5        

D. Phông chữ hiện thời là G5 

Câu 2. Chương trình bảng tính là phần mềm được thiết kế để giúp em? 

A. Soạn thảo văn bản.        
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B. Xem dữ liệu. 

C. Luyện tập gõ phím.        

D. So sánh, sắp xếp, tính toán. 

Câu 3. Trong các phần mềm có tên sau, phần mềm nào là phần mềm bảng tính? 

A. MicroSoft Word        

B. MicroSoft PowerPoint 

C. MicroSoft Excel        

D. MicroSoft Access 

Câu 4. Trong ô tính xuất hiện ###### vì: 

A. Độ rộng của cột quá nhỏ không hiển thị hết dãy số quá dài. 

B. Độ rộng của hàng quá nhỏ không hiển thị hết dãy số quá dài. 

C. Công thức nhập sai 

D. Tính toán ra kết quả sai. 

Câu 5. Để kích hoạt ô D100 nằm ngoài phạm vi màn hình (em không nhìn thấy), ngoài 

cách dùng chuột và các thanh cuốn em có thể: 

A. Gõ địa chỉ vào thanh công thức        

B. Gõ địa chỉ D100 vào hộp tên 

C. Nháy chuột tại nút tên cột D         

D. Nháy chuột tại nút tên hàng 100 

Câu 6. Để sửa dữ liệu trong ô tính em cần: 

A. Nháy đúp chuột trái vào ô cần sửa.        

B. Nháy nút chuột trái 

C. Nháy đúp chuột phải vào ô cần sửa        

D. Nháy nút chuột phải 

Câu 7. Màn hình làm việc của Excel khác màn hình làm việc của Word là gồm có : 

A. File, Trang tính, Home, Thanh công thức. 

B. Trang tính, Thanh công thức, Page Layout, Data. 

C. Thanh trạng thái, Thanh công thức, Fomulas 

D. Trang tính, Thanh công thức, Fomulas, Data. 

Câu 8. Để chọn một ô trên trang tính, em thực hiện: 

A. Nháy chuột tại nút tên hàng 

B. Nháy chuột tại nút tên cột 

C. Đưa con trỏ chuột tại nơi đó và nháy chuột. 

D. Kéo thả chuột từ một ô góc đến ô ở góc đối diện 
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II. TỰ LUẬN  

Câu 1. Giả sử ô A2 chứa công thức: = A1+ B1 Công thức sẽ được điều chỉnh như thế nào 

nếu: 

a) Sao chép ô A2 sang ô C2  

b) Di chuyển ô A2 sang ô G1 

Câu 2. Trình bày thao tác chèn thêm cột, hàng?  

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 2 

I. TRẮC NGHIỆM 

1 2 3 4 5 6 7 8 

C D C A B A D C 

II. TỰ LUẬN 

Câu 1:  

a) Ô C2 chứa công thức: =C1+D1 

b) Ô G1 chứa công thức:=A1+B1 

Câu 2: **Chèn thêm cột 

- Nháy chọn một cột 

- Mở bảng chọn Insert , chọn columns 

*Chèn thêm hàng:  

- Nháy chọn một hàng 

- Mở bảng chọn Insert ,chọn Rows 

 

3. Đề thi học kì 1 môn Tin 7 – Số 3 

TRƯỜNG THCS ĐỐNG ĐA ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

I. TRẮC NGHIỆM  

Câu 1. Cụm từ “A5” trong hộp tên có nghĩa là: 

A.Phím chức năng A5        

B.Ô ở hàng A cột 5 

C.Ô ở cột A hàng 5         

D.Phông chữ hiện thời là A5 
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Câu 2. Bạn Hồng đang mở bảng tính Danh sach lop em, bạn ấy muốn lưu lại với tên Bang 

diem lop em. Nếu em là Hồng, em sẽ thực hiện: 

A. Nháy vào nút lệnh  

B. Nhấn tổ hợp phím Ctrl + V 

C. File -> Save as 

D. File -> Save 

Câu 3. Muốn sữa dữ liệu trong một ô tính mà không cần nhập lại ta phải thực hiện như thế 

nào? 

A. Nháy đúp chuột trên ô tính và sửa dữ liệu 

B. Nháy chuột trên ô tính và sửa dữ liệu 

C. Nháy chuột đến ô tính cần sửa sau đó đưa chuột lên thanh công thức để sửa 

D. Cả hai phương án A và C 

Câu 4. Dữ liệu kiểu số trong các chương trình bảng tính: 

A. Mặc định căn trái 

B. Mặc định căn phải 

C. Mặc định căn giữa 

D. Mặc định căn đều 

Câu 5. Phần mở rộng của các tệp tin trong chương trình bảng tính: 

A rtf        

B .excel        

C .doc        

D .xls 

Câu 6. Để thoát khỏi Excel, ta thực hiện: 

A. Nhấn nút         

C. File -> Exit 

B. Alt + F4         

D. Tất cả đều đúng 

Câu 7. Để kết thúc nhập hàm hay công thức vào một ô tính ta dùng nút lệnh nào: 

A. End         

B. Enter 

C. Backspace         

D. Shift 

Câu 8. Trong các nút lệnh sau, nút lệnh nào dùng để mở bảng tính cũ? 
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A.  

B.  

C.  

D.  

II. TỰ LUẬN  

Câu 1. Muốn sửa dữ liệu trong một ô tính mà không cần nhập lại dữ liệu phải thực hiện 

thao tác gì?  

Câu 2. Nêu các bước lần lượt nhập một công thức và các kí hiệu phép toán trong chương 

trình bảng tính.  

Câu 3. Cho bảng dữ liệu chương trình bảng tính như sau:  

 A B C D E 

1 BẢNG ĐIỂM CỦA LỚP 7A 

2 Họ và tên Toán Tin Vật Lí Điểm TB 

3 Nguyễn Thị An 9 10 8  

4 Trần Văn Duy 7 9 8 ? 

5 Nguyễn Hoàng Hà 5 7 7  

  ? ? ?  

Yêu cầu: Sử dụng các hàm đã học để tính và cho biết kết quả 

a) Tính điểm trung bình của học sinh: Trần Văn Duy 

b) Tính tổng điểm môn Vật lí 

c) Tính điểm thấp nhất của môn Tin 

d) Tính điểm cao nhất của môn Toán 

 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 3 

I. TRẮC NGHIỆM 

1 2 3 4 5 6 7 8 
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C C D B D D B B 

II. TỰ LUẬN 

Câu 1: Muốn sửa dữ liệu trong một ô tính mà không cần nhập lại dữ liệu phải thực hiện 

thao tác: (trình bày 2 cách) 

- Cách 1: Nháy đúp vào ô cần sửa và sửa dữ liệu. 

- Cách 2: Nháy chọn ô cần sửa, nháy chuột lên thanh công thức và sửa dữ liệu trên đó rồi 

nhấn enter để kết thúc việc sửa dữ liệu. 

Câu 2: * Các bước nhập công thức: (2 điểm) 

- Bước 1: Chọn ô cần nhập công thức 

- Bước 2: Gõ dấu bằng 

- Bước 3: Nhập công thức 

- Bước 4: Nhấn phím Enter hoặc nháy chuột vào nút  trên thanh công thức 

* Các kí hiệu phép toán trong chương trình bảng tính (1 điểm) 

- Kí hiệu phép cộng: + 

- Kí hiệu phép trừ: - 

- Kí hiệu phép nhân: * 

- Kí hiệu phép chia: / 

- Kí hiệu phép lấy lũy thừa: ^ 

- Kí hiệu phép lấy phần trăm: % 

Câu 3: 

a) =AVERAGE(B4:D4) -> Kết quả là: 8 

b) =SUM(D3:D5) -> Kết quả là: 23 

c) =MIN(C3:C5) -> Kết quả là: 7 

d) =MAX(B3:B5) -> Kết quả là: 9 

4. Đề thi học kì 1 môn Tin 7 – Số 4 

TRƯỜNG THCS BẮC TRÀ MY ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

I. TRẮC NGHIỆM (4 điểm) 

Câu 1. Cụm từ “B5” trong hộp tên có nghĩa là: 

A. Phím chức năng B5         

B.Ô ở hàng B cột 5 

C. Ô ở cột B hàng 5         
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D.Phông chữ hiện thời là B5 

Câu 2. Muốn xoá cột em thực hiện: 

A. Chọn cột cần xóa, nhấn phím Delete        

B.Chọn cột cần xóa, vào Edit chọn Delete 

C. Chọn cột cần xóa, nhấn phím Enter        

 D. Chọn cột cần xóa, vào Edit chọn Columns 

Câu 3. Trong các nút lệnh sau, nút lệnh nào dùng để lưu bảng tính ? 

A.  

B.  

C.  

D.  

Câu 4. Dữ liệu kiểu chữ trong các chương trình bảng tính: 

A. Mặc định căn trái        

B. Mặc định căn phải 

C. Mặc định căn giữa        

D. Mặc định căn đều 

Câu 5. Trong các phát biểu sau, phát biểu nào sai? 

A. Dấu “=” là kí tự đầu tiên em cần gõ khi nhập công thức vào một ô 

B. Với mọi ô trong trang tính, nội dung hiện lên trong ô đó chính là nội dung hiện trên thanh 

công thức khi chọn ô đó 

C. Thay cho việc gõ địa chỉ của một ô tính trong công thức em có thể dùng chuột để chọn 

ô đó. Địa chỉ của ô được chọn sẽ được tự động đưa vào công thức; 

D. Có thể nhập nội dung cho một ô bất kì bằng cách gõ trực tiếp nội dung cần nhập vào 

hộp tên sau khi chọn ô đó. 

Câu 6. Phép nhân trong Excel được kí hiệu là gì? 

A.+        

B./        

C.-        

D. * 

Câu 7. Tên cột của trang tính được bắt đầu bằng gì? 

A. Các chữ cái A, B, C,….. 

B. Các chữ cái a,b,c,…. 
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C. Các chữ số 1,2,3,…. 

D. Cả a, b đều đúng 

Câu 8. Lợi ích của việc sử dụng địa chỉ ô tính trong công thức? 

A. Khi nội dung các ô trong công thức thay đổi thì kết quả cũng tự động tính toán. 

B. Khi nội dung các ô trong công thức thay đổi thì kết quả tự cập nhật lại. 

C. Khi nội dung các ô trong công thức thay đổi thì kết quả không thay đổi. 

D. Cả A và B đều đúng 

II. TỰ LUẬN (6 điểm) 

Câu 1. Nêu tên hàm, cách nhập hàm và các biến của hàm tính trung bình cộng (mỗi loại 

biến cho một ví dụ). (2 điểm) 

Câu 2. Dữ liệu trên trang tính có mấy dạng, kể tên và mỗi dạng cho một ví dụ? (1 điểm) 

Câu 3. (3 điểm) Cho các dữ liệu như hình sau: 

 

Em hãy quan sát hình trên rồi thực hiện các yêu cầu sau bằng cách sử dụng địa chỉ ô, 

hoặc khối: 

a. Viết công thức tính điểm trung bình môn Vật Lí, (1 điểm) 

b. Viết hàm xác định điểm cao nhất môn Toán; điểm thấp nhất môn Lịch Sử (2 điểm) 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 4 

I. TRẮC NGHIỆM 

1 2 3 4 5 6 7 8 

C B A A D D A B 

II. TỰ LUẬN 

Câu 1: - Tên hàm: Average 
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- Cách nhập hàm: =Average(a,b,c,d,…) 

- Các biến a,b,c,d,… có thể là: số, địa chỉ ô tính, địa chỉ khối hoặc có thể kết hợp số, địa 

chỉ khối và địa chỉ ô tính. 

VD: =Average(3,5,6); =Average(A1,A4,C2); =Average(C1:C10); =Average(2,C1,C2:C6); 

(Ví dụ tương tự vẫn cho điểm) 

Câu 2: * Dữ liệu trên trang tính gồm 2 dạng 

- Dữ liệu số là các số: 120;5; .. 

- Dữ liệu kí tự là dãy các chữ cái và các kí hiệu VD: lop 7A, diem, 

(Các VD khác đúng vẫn tính điểm) 

Câu 3: a. Công thức tính điểm trung bình môn Vật Lí 

= AVERAGE(C7,D7,E7,F7) HOẶC = AVERAGE(C7:F7) 

b. + Hàm xác định điểm cao nhất môn Toán 

=MAX(C6,D6,E6,F6) HOẶC = MAX(C6:F6) 

+ Hàm xác định điểm thấp nhất môn Lịch Sử 

= MIN(C8,D8,E8,F8) HOẶC = MIN(C8:F8)  

5. Đề thi học kì 1 môn Tin 7 – Số 5 

TRƯỜNG THCS BAO LA ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

I. Trắc nghiệm: Khoanh tròn vào đáp án đúng nhất.(2đ) 

Câu 1: Trong chương trình bảng tính Exel, thanh công thức dùng để: 

A. Hiển thị địa chỉ ô tính đang được chọn.                 

B. Hiển thị tên  cột. 

C. Nhập, hiển thị dữ liệu hoặc  công thức trong ô tính.      

D. Hiển thị tên hàng. 

Câu 2: Khối là tập hợp các ô kề nhau tạo thành hình chữ nhật. Địa chỉ khối được thể hiện 

như câu nào là đúng. 

A. H1…H5    

B. H1:H5    

C. H1 - H5   

D. H1->H5 

Câu 3: Trong bảng tính điện tử để tính 1002, cách viết nào sau đây là đúng.    

 A.  =100^2    
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B.  =100*100   

C.100+1000           

D. 100.100 

Câu 4: Giả sử ô A2 có giá trị 5, ô B8 có giá trị 27.Tính giá trị ô E2, biết rằng  

E2 = Sum(A2,B8) 

A.  5     

B.   27    

C.   16      

D.  32 

Câu 5: Trong ô tính xuất hiện ###### vì: 

A. Độ rộng của cột quá nhỏ không hiển thị hết dãy số quá dài. 

B. Độ rộng của hàng quá nhỏ không hiển thị hết dãy số quá dài.  

C. Tính toán ra kết quả sai. 

D. Công thức nhập sai . 

Câu 6: Làm cách nào để chọn 1 hàng trên trang tính? 

A. Nháy chuột tại nút tên hàng.      

B. Nháy chuột tại nút tên cột  

C. Đưa con trỏ chuột tới 1 ô và nháy chuột.    

D. Chọn tất cả trang tính 

Câu 7: Lợi ích của việc sử dụng địa chỉ ô tính trong công thức? 

A. Khi nội dung các ô trong công thức thay đổi thì kết quả cũng tự động tính toán. 

B. Khi nội dung các ô trong công thức thay đổi thì kết quả tự cập nhật lại. 

C. Khi nội dung các ô trong công thức thay đổi thì kết quả không thay đổi. 

D. Cả A và B đều đúng 

Câu 8: Trong chương trình bảng tính Exel, hàm Average dùng để: 

A. Tính tổng    

B. Tính hiệu    

C. Tính trung bình    

D. Tính giá trị nhỏ nhất 

II Tự luận:(8 điểm) 

Câu 1: (2 điểm) Nêu các thành phần chính trên trang tính?. 

Câu 3: (2 điểm)Hãy nêu cách chèn thêm cột ? Cách chèn thêm hàng ? cách xóa cột ? 

Cách xóa hàng ? 

Câu 4: Cho bảng tính như hình sau: 



    Website: www.eLib.vn  | Facebook: eLib.vn 
 

eLib.vn: Thư viện trực tuyến miễn phí 13 

 

 

Yêu cầu:  Dùng hàm thích hợp (sử dụng địa chỉ ô tính) để tính tổng điểm(tại 1), điểm trung 

bình (tại 2), tính điểm trung bình cao nhất (3) và tính điểm trung bình nhỏ nhất(4) (2đ).  

Câu 3: Giả sử ô A2 chứa công thức: = A1+ B1 Công thức sẽ được điều chỉnh như thế nào nếu: 

1) Sao chép ô A2 sang ô C2(1đ). 

2) Di chuyển ô A2 sang ô G1 (1đ). 

 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 5 

I. Phần trắc nghiệm:(Mỗi câu đúng được 0.25 điểm) 

Câu 1 2 3 4 5 6 7 8 

Đáp án C B A D A A D C 

II. Phần tự luận: 

Câu 1: Các thành phần chính trên trang tính: (1đ) 

- Các hàng, các cột, các ô. 

- Hộp tên: Hiển thị địa chỉ ô dược chon. 

- Khối: Là nhóm các ô liền kề nhau tạo thành hình chữ nhật. 

- Thanh công thức: Cho biết nội dung của ô đang được chon. 

Câu 2:  

- Chèn cột, chèn hàng 

Chọn cột  Insert Columns 

Chọn hàng  Insert Rows 

- Xóa cột, xóa hàng 

Chọn cột  Edit Delete 

Chọn hàng  Edit Delete 
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Câu 3:(Nhập đúng vào mỗi ô được 0.5 điểm) 

Ô I5 =sum(C5,D5,E5,F5,G5,H5) hoặc =sum(C5:H5) 

Ô J5 =Average(C5:H5) 

Ô J11 = Max (J5:J10) 

Ô J12 = Min (J5:J10) 

Câu 4:  

a. Ô C2 chứa công thức: =C1+D1  

b. Ô  G1 chứa công thức:=A1+B1  

6. Đề thi học kì 1 môn Tin 7 – Số 6 

TRƯỜNG THCS PHAN ĐĂNG LƯU ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

A. TRẮC NGHIỆM  

Câu 1. Trong các phần mềm có tên sau, phần mềm nào là phần mềm bảng tính ? 

A. MicroSoft Word        

B. MicroSoft Excel       

C. MicroSoft Pain          

D. MicroSoft Access 

Câu 2. Để chèn thêm hàng em thực hiện các thao tác nào sau đây ? 

A. Click trái tại hàng chọn Insert           

B. Click phải tại hàng chọn Delete 

C. Click phải tại hàng chọn Insert                     

D. Click phải tại hàng chọn Format Cells 

Câu 3. Trên trang tính có bao nhiêu dữ liệu ? 

A. 1                                   

B. 2                     

C. 3                                   

D. 4  

Câu 4. Để kích hoạt ô D200 nằm ngoài phạm vi màn hình, ngoài cách dùng chuột và thanh 

cuốn em có thể: 

A. gõ địa chỉ vào thanh công thức  

B. gõ địa chỉ D200 vào ô hộp tên  

C. nháy chuột tại nút tên cột D                                
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D. nháy chuột tại nút tên hàng 200 

Câu 5. Thông tin được lưu dưới dạng bảng có ưu điểm gì ? 

A. Tính toán nhanh chóng              

B. Dễ theo dõi, tính toán nhanh chóng 

C. Dễ sắp xếp                                    

D. Dễ sắp xếp, dễ theo dõi, tính toán nhanh chóng 

Câu 6. Muốn sao chép nội dung trên ô tính ta dùng tổ hợp phím nào ? 

A. Ctrl + X                         

B. Ctrl + V                      

C. Ctrl + C                          

D. Ctrl + P 

Câu 7. Địa chỉ ô E7 nằm ở vị trí: 

A.  cột 7, dòng E               

B.  cột E, dòng 7           

C.  dòng E, dòng 7             

D. cột E, cột 3 

Câu 8. Khi mở một bảng tính mới thường có bao nhiêu sheet ? 

A. 1 sheet                            

B. 2 sheet                        

C. 3 sheet                            

D. 4 sheet 

Câu 9. Trong các công thức sau, công thức nào đúng ? 

A. =Max(“a1: a5”)        

B.  =Max(a1:a5)             

C.  =Max(“a1,a5”)              

D.  =Max(„a1:a5‟) 

Câu 10. Nếu một trong các ô tính có các kí hiệu #####, điều đó có nghĩa là gì ?  

A. Dòng chứa ô đó có độ cao thấp nên không hiển thị hết chữ số          

B. Công thức nhập sai              

C. Ô tính đó có độ rộng hẹp nên không hiển thị hết chữ số                    

D. Nhập sai dữ liệu. 

Câu 11.  Khi nhập công thức, dấu gì được nhập đầu tiên ? 

A. Dấu hai chấm       

B. Dấu ngoặc đơn                 
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C.  Dấu nháy         

D.  Dấu bằng 

Câu 12. Dải lệnh dùng để thực hiện các phép tính với các số và xử lí dữ liệu là : 

A. home                            

B. formulas                            

C. data                          

D. formulas và data 

II. Chọn từ hoặc cụm từ thích hợp để điền vào chỗ (...) của các câu sâu đây và ghi vào giấy 

bài làm (Ví dụ 1. con người). Mỗi từ hoặc cụm từ điền đúng được 0,25 điểm. 

Trang tính gồm các ….(1)….. và các …..(2)…… là miền làm việc của bảng tính. Vùng giao 

nhau giữa cột và hàng là ….(3)…… dùng để chứa …..(4)…… 

III. Nối mỗi câu ở cột A với mỗi câu ỏ cột B để tạo thành câu hoàn chỉnh và ghi vào giấy bài 

làm (ví dụ câu 1 chọn đáp án A ghi 1-A). Mỗi câu nối đúng đạt 0,25 điểm. 

Cột A Cột B 

1. Average A. là hàm tính tổng 

2. Sum B. là hàm xác định giá trị nhỏ nhất 

3. Max C. là hàm tính trung bình cộng 

4. Min D. hàm làm tròn số nguyên 

 E. là hàm xác định giá trị lớn nhất 

 

B. TỰ LUẬN  

Câu 1. Trình bày thao tác sao chép và di chuyển dữ liệu trên trang tính. 

Câu 2. Viết biểu thức toán học sau sang chương trình bảng tính. 

a. (10-5)2 + 4 x 5  

c.   2 + 75  x 4 

b. (5 x 42) : 2                               

d. (15 + 5) x 4%   

Câu 3. Cho bảng tính sau: 
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a. Dùng công thức tính ĐTB của 3 môn Toán, Văn, Anh trong ô F4, F5.  

b. Dùng hàm thích hợp để xác định ĐTB lớn nhất và ĐTB nhỏ nhất trong ô F6, F7.  

 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 6 

A. TRẮC NGHIỆM  

I. (3,0 điểm) Chọn đáp án đúng  

1 2 3 4 5 6 7 8 9 10 11 12 

B C B B D C B C B C D D 

 

II. Điền từ, cụm từ đúng đạt 0,25 điểm 

1. cột               2. hàng                  3. ô tính               4. dữ liệu 

II. Mỗi câu nối đúng đạt 0,25 điểm 

1. C                           2. A                                 3. E                          4. B 

II. TỰ LUẬN.  

Câu 1.  

* Thao tác sao chép:  

B1. Chọn ô hoặc các ô cần sao chép dữ liệu 

B2. Chọn lệnh Copy trong nhóm Clipboard trên dải lệnh home 

B3. Chọn ô muốn đưa thông tin cần sao chép vào 

B4. Chọn lệnh Paste trong nhóm Clipboard 

* Thao tác di chuyển:  

B1. Chọn ô hoặc các ô cần di chuyển dữ liệu 

B2. Chọn lệnh Cut trong nhóm Clipboard trên dải lệnh home 

B3. Chọn ô muốn đưa thông tin cần di chuyển vào 

B4. Chọn lệnh Paste trong nhóm Clipboard 

Câu 2.  



    Website: www.eLib.vn  | Facebook: eLib.vn 
 

eLib.vn: Thư viện trực tuyến miễn phí 18 

 

* Viết biểu thức toán học sang chương trình bảng tính 

a. (10-5)2 + 4 x 5 => (10-5)^2 +4*5 

b. (5 x 42) : 2 => (5*4^2) / 2                             

c.   2 + 75  x 4 => 2+7^5 *4 

d. (15 + 5) x 4% => (15+5)*4%  

Câu 3.   

a. Tính ĐTB:  

F4 = (8+9+8)/3 = 8,33 

F5 = (9+9+10)/3 = 9,33 

b. Xác định GTLN, GTNN:  

F6 = max(F4:F5) = 9,33 

F7 = max(F4:F5) = 8,33 

7. Đề thi học kì 1 môn Tin 7 – Số 7 

TRƯỜNG THCS QUANG TRUNG ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

A - TRẮC NGHIỆM  

Câu 1: Ô tính C3 có công thức =A3+B3. Nếu em sao chép ô C3 sang ô C5 thì ở ô C5 sẽ là: 

A. =A3+B3  

B. =B3+A3  

C. =A5+B5  

D. =C6+D3 

Câu 2: Khi nhập công thức vào ô, em phải gõ dấu nào trước tiên: 

A. Dấu ngoặc đơn ( )  

B. Dấu (#) .  

C. Dấu cộng (+)  

D. Dấu bằng (=) 

Câu 3: Thanh công thức của Excel dùng để: 

A. Nhập địa chỉ ô đang được chọn 

B. Xử lý dữ liệu 

C. Hiển thị công thức 

D. Nhập và hiển thị dữ liệu hoặc công thức trong ô tính 

Câu 4: Chương trình bảng tính là phần mềm được thiết kế để giúp em? 
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A. Soạn thảo văn bản.  

B. Xem dữ liệu. 

C. Luyện tập gõ phím.  

D. So sánh, sắp xếp, tính toán. 

Câu 5: Địa chỉ của khối ô là: 

A. B1:E4  

B. A2-C4  

C. A1,E4  

D. B1;E4 

Câu 6: Giả sử trong ô D3 chứa công thức =B3+C3. Ta thực hiện sao chép nội dung công 

thức trong ô D3 sang ô D4 thì kết quả của ô D4 sẽ là: 

A. = B4+D4  

B. = B3+C3  

C. =B3+D3  

D. = B4+C4 

Câu 7: Muốn chọn hai khối không kề nhau ta nhấn cần nhấn giữ phím: 

A. Alt  

B. Shift  

C. Ctrl  

D. Enter 

Câu 8: Để tính tổng giá trị trong các ô C1 và C2, sau đó chia cho giá trị trong Ô B3 . Công 

thức nào đúng trong các công thức sau đây : 

A. = (C1+C2)/B3  

B. =C1+C2\B3  

C. =  (C1 + C2 )\B3  

D. (C1+C2)/B3 

Câu 9: Trong các phần mềm có tên sau, phần mềm nào là phần mềm bảng tính? 

A. MicroSoft Word  

B. MicroSoft PowerPoint 

C. MicroSoft Excel  

D. MicroSoft Access 

Câu 10: Để tính tổng giá trị trong các ô E3 và F7, sau đó nhân với 10% ta thực hiện bằng 

công thức nào sau đây? 

A. (E3+F7)*10%  
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B. = (E3+F7)*10%  

C. = (E3+F7)10%  

D. (E3+F7)10%. 

B - TỰ LUẬN  

Câu 1 (1 điểm): Nêu các bước nhập công thức vào trang tính? 

Câu 2 (2 điểm): Nêu cú pháp và công dụng hàm SUM và hàm MAX?  

Câu 3 (2 điểm): Giả sử trong ô A2 chứa số 10, ô A3 chứa số 20, ô A4 chứa số 30.  

a) Sử dụng hàm AVERAGE để tính giá trị trong các ô A2, A3, A4 theo đúng cú pháp. Sau 

đó cho biết kết quả? 

b) Sử dụng hàm MAX để tính giá trị trong các ô A2, A3, A4 theo đúng cú pháp. Sau đó cho 

biết kết quả?  

 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 7 

A – Trắc nghiệm  

1 2 3 4 5 6 7 8 9 10 

C D D D A B C A C B 

B – Tự luận  

Câu 1: - Chọn 1 ô cần nhập công thức 

- Gõ dấu bằng (=) 

- Nhập công thức 

- Nhấn phím Enter để kết thúc 

Câu 2: * Hàm SUM 

- Cú pháp =SUM(a,b,c,...) 

- Cộng dụng: Tính tổng của một dãy các số. 

* Hàm MAX 

- Cú Pháp =MAX(a,b,c,...) 

- Công dụng: Xác định giá trị lớn nhất trong một dãy số 

Câu 3: a. =AVERAGE(A2,A3,A4) hoặc =AVERAGE(10,20,30) 

Kết quả là: 20 

b. =MAX(A2,A3,A4) hoặc =MAX(10,20,30) 

Kết quả là: 30 

8. Đề thi học kì 1 môn Tin 7 – Số 8 

TRƯỜNG THCS LÊ LỢI ĐỀ THI HỌC KÌ 1 
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MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

A - TRẮC NGHIỆM  

Câu 1: Thanh công thức của Excel dùng để: 

A. Nhập và hiển thị dữ liệu hoặc công thức trong ô tính 

B. Nhập địa chỉ ô đang được chọn 

C. Hiển thị công thức 

D. Xử lý dữ liệu 

Câu 2: Khi nhập công thức vào ô, em phải gõ dấu nào trước tiên: 

A. Dấu cộng (+)  

B. Dấu (#) .  

C. Dấu ngoặc đơn ( )  

D. Dấu bằng (=) 

Câu 3: Muốn chọn hai khối không kề nhau ta nhấn cần nhấn giữ phím: 

A. Shift  

B. Alt  

C. Enter  

D. Ctrl 

Câu 4: Trong các phần mềm có tên sau, phần mềm nào là phần mềm bảng tính? 

A. MicroSoft Word B. MicroSoft PowerPoint 

C. MicroSoft Excel D. MicroSoft Access 

Câu 5: Chương trình bảng tính là phần mềm được thiết kế để giúp em? 

A. Soạn thảo văn bản. B. Xem dữ liệu. 

C. Luyện tập gõ phím. D. So sánh, sắp xếp, tính toán. 

Câu 6: Địa chỉ của khối ô là: 

A. B1:E4 B. A2-C4 C. A1,E4 D. B1;E4 

Câu 7: Giả sử trong ô D3 chứa công thức =B3+C3. Ta thực hiện sao chép nội dung công 

thức trong ô D3 sang ô D4 thì kết quả của ô D4 sẽ là: 

A. = B4+D4 B. = B3+C3 C. =B3+D3 D. = B4+C4 

Câu 8: Để tính tổng giá trị trong các ô E3 và F7, sau đó nhân với 10% ta thực hiện bằng 

công thức nào sau đây? 

A. (E3+F7)10%. B. (E3+F7)*10% C. = (E3+F7)*10% D. = (E3+F7)10% 

Câu 9: Để tính tổng giá trị trong các ô C1 và C2, sau đó chia cho giá trị trong Ô B3 . Công 

thức nào đúng trong các công thức sau đây : 
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A. = (C1+C2)/B3 B. =C1+C2\B3 C. =  (C1 + C2 )\B3 D. (C1+C2)/B3 

Câu 10: Ô tính C3 có công thức =A3+B3. Nếu em sao chép ô C3 sang ô C5 thì ở ô C5 sẽ 

là: 

A. =A3+B3 B. =A5+B5 C. =C6+D3 D. =B3+A3 

B - TỰ LUẬN  

Câu 1 (1 điểm): Nêu các bước nhập công thức vào trang tính? 

Câu 2 (2 điểm): Nêu cú pháp và công dụng hàm SUM và hàm MAX?  

Câu 3 (2 điểm): Giả sử trong ô A2 chứa số 10, ô A3 chứa số 20, ô A4 chứa số 30.  

a) Sử dụng hàm AVERAGE để tính giá trị trong các ô A2, A3, A4 theo đúng cú pháp. Sau 

đó cho biết kết quả? 

b) Sử dụng hàm MAX để tính giá trị trong các ô A2, A3, A4 theo đúng cú pháp. Sau đó cho 

biết kết quả?  

 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 8 

A – Trắc nghiệm  

Câu 1 2 3 4 5 6 7 8 9 10 

Đ.án A D D C D A B C A B 

B – Tự luận (5 điểm) 

Câu 1: - Chọn 1 ô cần nhập công thức 

- Gõ dấu bằng (=) 

- Nhập công thức 

- Nhấn phím Enter để kết thúc 

Câu 2: * Hàm SUM 

- Cú pháp =SUM(a,b,c,...) 

- Cộng dụng: Tính tổng của một dãy các số. 

* Hàm MAX 

- Cú Pháp =MAX(a,b,c,...) 

- Công dụng: Xác định giá trị lớn nhất trong một dãy số 

Câu 3: a. =AVERAGE(A2,A3,A4) hoặc =AVERAGE(10,20,30) 

Kết quả là: 20 

b. =MAX(A2,A3,A4) hoặc =MAX(10,20,30) 

Kết quả là: 30 

9. Đề thi học kì 1 môn Tin 7 – Số 9 
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TRƯỜNG THCS NGUYỄN VĂN TRỖI ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

Hãy  tròn vào chữ cái đứng đầu cho đáp án đúng nhất.  

Câu 1: Một bảng tính có thể bao gồm: 

A. 1 trang tính.              

B. 2 trang tính.             

C. 3 trang tính.        

D. Nhiều trang tính. 

Câu 2: Khi mở một bảng tính mới em thường thấy có: 

A. Một trang tính.      

B. Hai trang tính.           

C. Ba trang tính.            

D. Bốn trang tính. 

Câu 3: Câu nào sau đây đúng? 

A. Trang tính gồm các cột và các hàng. 

B. Vùng giao nhau giữa các cột và hàng là cửa sổ bảng tính. 

C. Các cột của trang tính được đánh thứ tự từ phải sang trái với các kí tự A, B, C… 

D. Các hàng của trang tính được đánh thứ tự từ trên xuống dưới các kí tự A, B, C… 

Câu 4: Giao của hàng và cột gọi là: 

A. Một cột .            

B. Một khối.                  

C. Một ô.                        

D. Một hàng. 

Câu 5: Khối là: 

 A. Các trang tính tạo thành.    

B. Các ô cách nhau.      

 C. Một nhóm các ô liền kề nhau.              

D. là 1 nhóm khối ô rời rạc. 

Câu 6: Có thể quan sát ở đâu trên trang tính để biết được một ô chứa công thức hay chứa 

dữ liệu? 

A. Thanh công cụ.                

B. Thanh công thức.              

C. Thanh bảng chọn.     
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D. Hộp tên. 

Câu 7: Cụm từ G5 trong hộp tên   có nghĩa là: 

A. Phím chức năng G5.                                        

B. Phông chữ hiện thời là G5. 

C. Ô ở cột G hàng 5.                                              

D. Ô ở hàng G cột 5. 

Câu 8: Hộp tên cho biết: 

A. Nội dung của ô đang được chọn.                      

B. Địa chỉ của ô đang được chọn. 

C. Công thức của ô đang được chọn.                   

D. Dữ liệu của ô đang được chọn. 

Câu 9: Địa chỉ của khối gồm các ô nằm trên các cột C, D, E và nằm trên các hàng 2, 3, 4, 5 

là: 

A. C2: E4.                     

B. C2 : E5.                       

C. D2  : E5.                 

D. C3 : E5. 

Câu 10: Giả sử cần tính tổng giá trị của các ô B2 và E4, sau đó nhân với giá trị trong ô C2. 

Công thức nào trong số các công thức sau đây là đúng: 

A. =(E4+B2)*C2.          

B. (E4+B2)*C2.         

C. =C2(E4+B2).          

D. (E4+B2)C2. 

Câu 11: Ở một ô tính có công thức sau: =((E5+F7)/C2)*A1 với E5 = 2, F7 = 8 , C2 = 2, A1 

= 20 thì kết quả trong ô tính đó sẽ là: 

A. 10.                      

B. 100.               

C. 200.                       

D. 120. 

Câu 12: Nếu trong 1 ô tính có các ký hiệu ########, điều đó có nghĩa là? 

A. Công thức nhập sai và bảng tính thông báo lỗi. 

B. Dòng chứa ô đó có độ cao thấp nên không hiển thị hết chữ số. 

C. Ô tính đó có độ rộng hẹp nên không hiển thị hết chữ số. 

D. Nhập sai dữ liệu. 
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Câu 13: Hàm AVERAGE là hàm dùng để: 

A. Tính tổng.               

B. Tìm số nhỏ nhất.       

C. Tìm số trung bình cộng.            

D. Tìm số lớn nhất. 

Câu 14: Kết quả của hàm sau: =SUM(A1:A3), trong đó: A1= 5; A2=39; A3=52 

A. 96.                      

B. 89.                 

C. 95.                   

D.Không thực hiện được. 

Câu 15: Kết quả của hàm sau: =AVERAGE(A1:A4), trong đó: A1=16; A2=29; A3= 24 ; 

A4=15 

A. 23.                       

B. 21.                 

C. 20.                             

D. Không thực hiện được. 

Câu 16: Kết quả của hàm sau : =MAX(A1,A5), trong đó: A1=5, A2=8; A3=9; A4=10; A5=2 

A.2.                        

B. 10.                 

C. 5.                               

D. 34. 

Câu 17: Nếu khối A1:A5 lần lượt chứa các số 10, 7, 9, 27, 2 kết quả phép tính nào sau đây 

đúng: 

A. =MAX(A1,A5,15) cho kết quả là 1.            

B. =MAX(A1:A5, 35) cho kết quả là 27. 

C. =MAX(A1:A5) cho kết quả là 27.     

D. =MAX(A1:A5) cho kết quả là 10.                  

Câu 18: Kết quả của hàm =Average(3,8,10) là:  

A.  21.                      

B.  7.                  

C.  10.                           

D.  3. 

Câu 19: Để tính giá trị trung bình của ô A1 , B1, C1, các cách tính nào sau đâu là đúng: 

A. =Sum ( A1+B1+C1).                    
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B. =Average(A1,B1,C1)/3. 

C. =Average (A1,B1,C1).                

D. =Average (A1,B1,C1). 

Câu 20: Để tính trung bình cộng A1,A2,A3,A4 em dùng công thức: 

A. =Average(A1:A4).                      

B. =Average(A1:A4)/6. 

C. Average(A1:A4)/4.                      

D. Average(A1,A2,A3,A4). 

Câu 21.   Để tạo biểu đồ ta sử dụng nút lệnh nào dưới đây ?  

   A.         

B.                           

C.             

D.  

Câu 22.  Ô A1 của trang tính có số 1.753; Sau khi chọn ô A1, nháy chuột 1 lần vào nút 

  thì kết quả hiển thị ở ô A1 sẽ là: 

A. 1.7530        

B. 1.76                                    

C. 1.753                      

D. 1.75 

Câu 23. Trong ô A1 có nội dung “ Bảng điểm lớp 7B”. Để căn chỉnh nội dung này vào giữa 

bảng điểm (Giữa các cột từ A đến G). Sau khi chọn các ô từ A1 đến G1, em chọn nút lệnh? 

A.   

B.   

C.   

D.  

Câu 24. Để  thay đổi font chữ trang tính ta nút lệnh nào dưới đây ? 

A.      

B.                                  
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C.                  

D.  

Câu 25. Để làm cho chữ trong ô tính vừa in đậm vừa in nghiêng ta sử dụng các nút lệnh? 

A.               

B.                        

C.                         

D.  

Câu 26. Để tô màu chữ trong ô tính ta sử dụng nút lệnh nào dưới đây ? 

A.     

B.    

C.      

D.  

Câu 27. Để dữ liệu trong cột được sắp xếp giảm dần  ta sử dụng nút lệnh nào dưới đây ? 

A.                            

B.                      

C.                      

D.  

Câu 28. Nút  trong hình ảnh xuất hiện khi ta mở lệnh nào ? 

 

A. Home → Filter → Show All  

B. Data → Sort Ascending 

C. Data → Sort Descending  

D. Home → Sort & Filter → Filter 

Câu 29. Muốn hiển thị toàn bộ danh sách mà vẫn tiếp tục làm việc với AutoFilter thì chọn: 

A. Nháy nút   
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B. Nháy nút  

C. Nháy nút    

D. Nháy nút  

Câu 30. Để kẻ đường biên của các ô tính, em sử dụng nút lệnh nào: 

A.  

B.   

C.   

D.  

 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 9 

1 2 3 4 5 6 7 8 9 10 

D C C C C B C B B A 

11 12 13 14 15 16 17 18 19 20 

B C C A B B C B C A 

21 22 23 24 25 26 27 28 29 30 

A D C D B A C C B B 

 

10. Đề thi học kì 1 môn Tin 7 – Số 10 

TRƯỜNG THCS NGUYỄN HUY TỰ ĐỀ THI HỌC KÌ 1 

MÔN TIN HỌC 7 

NĂM HỌC 2019-2020 

I. TRẮC NGHIỆM (5 điểm) 

Câu 1. Chọn từ thích hợp điền vào dấu …..: 

Thanh công thức cho biết ..................... của ô tính đang được chọn. 

A. địa chỉ.        

B. nội dung.        

C. kiểu chữ        

D. Tất cả đều sai 

Câu 2. Trong trò chơi đám mây (Clouds) để quay lại đám mây đã đi qua, ta nhấn phím 

A. Space        

B. Enter        

C. Backspace        
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D. Tab 

Câu 3. Kết quả của hàm sau: =SUM(A1:A3), trong đó: A1= 5; A2=39; A3=52 

A. 96.        

B. 89.        

C. 95.        

D.Không thực hiện được. 

Câu 4. Ô tính đang được kích hoạt có gì khác so với các ô tính còn lại? 

A. Được tô màu đen 

B. Có con trỏ chuột nằm trong đó. 

C. Có đường viền nét đứt xung quanh. 

D.Có viền đậm xung quanh; 

Câu 5. Khi chiều dài dữ liệu kiểu số lớn hơn chiều rộng của ô thì Excel sẽ hiển thị trong ô 

các kí tự 

A. #        

B. *        

C. %         

D.& 

Câu 6. Các bước nhập công thức vào ô tính: 

A. Gõ dấu = → nhập công thức → chọn ô tính → nhấn Enter 

B. Gõ dấu = → chọn ô tính → nhập công thức → nhấn Enter 

C. Chọn ô tính → gõ dấu = → nhập công thức → nhấn Enter 

D. Chọn ô tính → nhập công thức → gõ dấu bằng → nhấn Enter 

Câu 7. Đưa con trỏ chuột đến tên cột rồi nháy chuột tại nút tên cột đó là thao tác: 

A.Chọn một hàng        

B.Chọn một cột 

C.Chọn một ô         

D.Chọn một khối 

Câu 8. Phần mở rộng của các tệp tin trong chương trình bảng tính: 

A rtf        

B .excel        

C .doc        

D .xls 

Câu 9. Giả sử ta có bảng tính sau: 
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Điểm TB môn được tính như sau: Văn, Toán nhân hệ số 2, các môn còn lại nhân hệ 

số 1. Công thức tổng quát tính điểm TB môn cho bạn Phương Anh là: 

A. (B2*2+C2+D2+E2*2+ F2)/7        

B. = (B2*2+C2+D2+E2*2+ F2)/7 

C. (B2+C2+D2+E2+F2)/5         

D. = (B2+C2+D2+E2+F2)/5 

Câu 10. Ở một ô tính có công thức sau: =((B2+C5)/C7)*D5 với B2 = 10, C5 = 5, 

C7 = 3, D5= 7 thì kết quả trong ô tính đó sẽ là: 

A. 20        

B. 25        

C. 35        

D. 19 

II. TỰ LUẬN (5 điểm) 

Câu 1: (1 điểm) Viết các biểu thức sau bằng các kí hiệu của chương trình bảng tính: 

a) 102 +        

Câu 3. Nêu cú pháp của các hàm SUM, AVERAGE, MAX, MIN(2 điểm) 

Câu 2. (2 điểm) Giả sử ta có bảng tính sau: 

 

Lập công thức để tính: 

a) ĐTB của từng bạn 

b) Tổng điểm từng môn 
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c) ĐTB cao nhất lớp 

d) ĐTB thấp nhất lớp 

ĐÁP ÁN ĐỀ THI HỌC KÌ 1 MÔN TIN HỌC 7 – SỐ 10 

I. TRẮC NGHIỆM 

1 2 3 4 5 6 7 8 9 10 

B C A D A C B D B B 

II. TỰ LUẬN 

Câu 1: 

a) 10^2 + (24-4)/4; 

b) 20*a^2 / 16 

Câu 2: Hàm tính tổng (SUM) 

=SUM(a,b,c,...) 

Hàm tính trung bình cộng (AVERAGE) 

= AVERAGE(a,b,c,...) 

Hàm tìm giá trị lớn nhất (MAX) 

=MAX(a,b,c,...) 

Hàm tìm giá trị nhỏ nhất (MIN) 

=MIN(a,b,c,...) 

Câu 3: 

1. ĐTB của từng bạn: =average(C3:F3) 

2. Tổng điểm từng môn: =sum(C3:C6) 

3. ĐTB cao nhất lớp: =max(G3:G6) 

4. ĐTB thấp nhất lớp: =min(G3:G6) 

 

 


